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1. INTRODUCTION

TAMARIN, the Toolbox for Analysis of Mata Atlantica Restoration Incentives, is a planning
support system to assist in regional conservation planning. Itis a customized ArcView project
file, with scripts written specifically for this application in south Bahia for the Central Atlantic
Forest Corridor project. It has been tailored to the GIS data sets compiled for this project. It
was designed as an exploratory tool for testing various strategies and assumptions about future
land use in south Bahia against a set of descriptors of the desired forest landscape
configuration that is believed adequate to meet biodiversity conservation objectives. The
toolbox is NOT intended as a decision-making device to usurp the role of policy makers. This
document is a manual to instruct users in the functioning and operation of TAMARIN to create
and evaluate conservation strategies.

TAMARIN performs two sets of GIS-based procedures. First, it assists planning teams to
design scenarios, and second it evaluates the economic and ecological consequences of these
scenarios. Scenarios can be created by drawing on an electronic map or by defining rules for
selection based on conservation and/or economic criteria. Scenarios can be constrained by a
maximum budget limit. The framework can then calculate the ecological effects and costs of the
scenario and create a series of GIS themes, tables, graphics, and reports that summarize the
salient features for comparison with the current situation, projected future conditions, and other
scenarios.

This manual is intended to be a complete user’s guide to the toolbox, but assumes the reader is
already familiar with ArcView and Windows. To make the manual easier to follow, program
names are always shown in bold font and pre-defined input and output file names are in bold
Italics. Menus and their options are listed in 'single quotes.' Pre-defined program variables and
parameters are generally underlined.

Before describing the software and its use, here are definitions of key terms that are used
throughout the manual:

» bioregion—a subdivision of the planning region or corridor that distinguishes distinct
biological composition. In south Bahia, bioregions were delineated by vegetation formations
(east to west) and assemblages of endemic flora and fauna (north to south). Section 3.4
describes this GIS theme in more detail. Representation (see below) goals are set for each
bioregion.

* business-as-usual scenario—a future land use pattern that is expected from current trends if
no conservation intervention occurs. One such scenario is provided with TAMARIN (Section
3.2), but the system allows users to substitute their own projections.

e cabruca—a traditional system of growing cocoa under the shade of native overstory trees,
often with intervening patches of primary forest, and therefore considered important for the
preservation of flagship primate species in the corridor (Alger and Caldas 1994).

» core forest—primary or restored forest (see below) that is beyond the influence of edge
effects and thus provides habitat for forest interior-dwelling species.

» corridor—a planning region comprising a mosaic of land uses, including a network of parks,
reserves and other areas of less intensive use whose management is integrated to ensure
the survival of the largest possible spectrum of species unique to that region.



depth-of-edge influence zone—the transition zone between the edge of agriculture, pasture,
or urban land uses (see below) and core forest (see definition above) in which it is assumed
that ecological processes such as fire regime and microclimate are altered. In TAMARIN,
users can specify the distance of the depth-of-edge influence zone, although we provide a
default value of 300 m based on Gascon et al. (2000).

easement opportunity cost—this represents an estimate of the opportunity costs to the
landowner if their land were included in the conservation corridor. Because the owner
maintains title to the land and some opportunities to use it, this value is less than the land
value (see below). Several estimates of easement value were made based on different
assumptions of the opportunity costs for forest and cabruca land (Section 3.1).

edge forest—forest adjacent to agriculture, pasture, or urban land uses and therefore
subject to conditions hostile to forest regeneration, which leads to a decline in its value as
forest habitat for interior-dwelling species (in contrast to core forest) (Gascon et al. 2000).

Environmental Benefits Index—we use this term that was coined for the USDA Conservation
Reserve Program (described in Chomitz et al. 1999) as a measure of the ecological
feasibility of restoring or protecting a planning unit. Several versions of an environmental
benefits index are provided in TAMARIN based on different assumptions of the value for
secondary forest and cabruca land (Section 3.1).

framework—we refer to TAMARIN as a framework because it structures the design and
evaluation of alternative conservation strategies. We prefer this term to “model”, which
implies an underlying ecological or social process.

gap-crossing distance—the distance across non-forest habitat that a species is known or
believed to be able to traverse to move between forest patches. Patches of forest
separated by less than this distance are considered part of the same functional patch. In
TAMARIN, we assume this distance to be 1km, based on expert opinion about the ecology
of the yellow-breasted capuchin, although users have the option to modify this variable.

incentive offer— a potential payment to a landowner in exchange for a modification in land
use that will achieve desired conservation objectives, prescribed by a formula or schedule.
Landholders accept or reject the offer depending on whether it is greater or less than the
opportunity costs associated with the change in land use. In TAMARIN, we assume that
incentive offers are equal across the entire corridor, although the user can specify the
amount in a given scenario.

land value—the market value of the land and improvements, as imputed from a survey of
~250 farms in the corridor. This represents the price of acquiring title to the land (Section
3.1).

matrix—the dominant land use or land cover of a region in which forest fragments are
embedded. Some matrix types are more conducive to biodiversity conservation than others.
For instance, a matrix of cabruca is more valuable to the maintenance of forest primates
than a matrix of pasture.

planning unit—the spatial unit used to analyze patterns of biotic diversity and land values in
order to identify priority areas. For this project, we have chosen square cells of 990 meters
on a side as the planning units. These units are large enough to compensate for uncertainty



in the spatial data and to keep the size of the analysis manageable, yet small enough to
allow flexible selection of alternative scenarios that respond to spatial variation in costs,
restoration suitability, and existing land uses.

» redundancy—designating multiple sites for each element of biodiversity as backups to guard
against catastrophic environmental or population fluctuations (Shaffer and Stein 2000).

* representation—maintain the full range of biodiversity, including species, habitats,
environmental types, and genetic variation by designating a network of sites that saves
some of everything (Shaffer and Stein 2000).

* reserves—lands legally protected for biodiversity conservation.

» resilience—designating sites of adequate size so that natural processes can operate at their
characteristic spatial and temporal scales and increase the likelihood of maintaining species
(Shaffer and Stein 2000).

» restored forest—forest that regenerates spontaneously (if near existing primary forest or
cabruca) or through reforestation (if isolated from existing forest) if the current land use is
abandoned, such as in response to an incentive payment to the landowner.

« scenario—an alternative strategic allocation of land uses guided by a set of assumptions
and choice of planning units for conservation intervention.

* viable habitat unit—a patch, or functionally connected set of patches (within the gap-
crossing distance—see above), that is at least as large as the specified minimum size to
maintain a population of one of the flagship species of the corridor, the yellow-breasted
capuchin. A viable habitat unit can include both core and edge forest, although scenarios
are evaluated in part by the proportion of edge forest. In TAMARIN, we assume that this
minimum area is 10,000 ha, based on a population viability analysis, although users can
modify the size for a scenario.

1.1 Background

Because environmental and socioeconomic conditions and conservation goals are location-
specific, we have developed a general methodology and applied it to a specific, policy-relevant
context linked to a World Bank-executed project: the construction of the Central Atlantic Forest
Biodiversity Corridor. The Atlantic Forest is by far the most threatened major ecosystem in
Brazil, with less than 8% of its original area remaining; Conservation International places it third
on its list of the nineteen highest-priority habitats for conservation on the planet (based on the
combination of threat and uniqueness). The northeastern section of this forest in south Bahia is
now reduced to relatively small, mostly nonviable fragments. The operational problem is to
deter further forest conversion and to induce abandonment of pasture and agriculture in the
interstices between forest fragments. This will result in forest regrowth, reconnecting fragments
into viable ecosystems. The impetus for the TAMARIN framework was a desire by the World
Bank to examine the potential for novel economic incentives targeted at landholders, including
purchase of conservation easements, sale of tradable development rights, and environmental
services payments.

The challenge is to find cheap, enforceable approaches that result in desirable land use
configurations. Pasture abandonment in different locations will have different ecological impacts,



depending on proximity to existing fragments. Costs of abandonment, and of protecting forest,
will also vary from place to place.

The underlying premises of the project are:

1. That there is substantial variation in opportunity costs of land within areas of conservation
interest.

2. That economic instruments can, in principle, exploit this variation to achieve conservation
goals at lower cost than is possible via command-and-control approaches.

The strategies for restoration can be quite complex because conservation planning must
balance multiple objectives and constraints, including cost efficiency. What seems obvious to
achieve one objective (e.g., protecting habitat-friendly land use practices) may not satisfy social
goals or may cost too much. The TAMARIN framework encourages planners to focus on
specific measurable conservation objectives and then develop scenarios to evaluate rather than
focusing initially on conservation actions.

Conservation science has identified three fundamental principles for conservation of
biodiversity: representation, resilience, and redundancy (Shaffer and Stein 2000). It is critical to
maintain the full range of biodiversity, including species, habitats, environmental types, and
genetic variation by representing this range in a network of sites managed primarily to ensure
their persistence. Besides affirming the intrinsic value of biodiversity, representation is a hedge
against the loss of species that play a crucial but undiscovered role in ecosystem functioning or
that could be a source of new biotechnological material. Even with samples of all biodiversity
elements represented in multiple sites, each site must be resilient or resistant to impacts from
adjoining landscapes. The most basic solution to this is to protect or restore sites of adequate
size so that natural processes can operate at their characteristic spatial and temporal scales. If
only a single large, resilient sample of each species or habitat is preserved, catastrophic
environmental or population fluctuations could still extirpate it. Therefore, the redundancy
principle prescribes managing multiple sites for each element of biodiversity. This replication of
sites also reinforces the representation goal by requiring samples across environmental
gradients with the corresponding variation in genotypic and ecotypic responses. With limited
resources, planners must choose between optimizing for resilience (size of each reserve) and
redundancy (number of reserves). Pelletier (2000) found that if species survivability is low in the
matrix, then single large reserves are optimal over many small reserves. In other words, the
minimal strategy to protect the whole ensemble of biodiversity in a region is to manage a system
of relatively large sites (not necessarily reserves) that represents several viable populations of
all species.

Many studies have reported on the degradation of forest fragments in a zone around their
perimeter (e.g., Gascon et al. 2000). Adjacent land use practices such as burning modify the
disturbance regime, which in turn can change the structure, composition, and function of the
forest edge for hundreds of meters. Not only does this alteration reduce the resilience of the
fragment, it is a dynamic process of attrition that in a harsh landscape matrix will continue to
penetrate inward and reduce the size of the core habitat. In fact, fragments as large as 1000
hectares could be entirely within this altered edge zone (Gascon et al. 2000) and thus be poor
representatives of primary forest habitat.

Conservation science has been more equivocal on the subject of connectivity and distance
between (or proximity of) protected sites (Shafer 2001). Designing a network of closely spaced



sites may foster connectivity with interpopulation gene flow and recolonization opportunities.
Having sites near each other, however, increases the risk of extinction from catastrophic events
such as wildfire, disease, and extreme climate events. The ultimate form of habitat connectivity
is to maintain corridors or linkages between habitat patches. These linkages contain the same
habitat as the patches or at least habitat that is adequately suitable for a species to traverse.
The corridor literature is similarly ambivalent about the pros and cons. Species differ in their
behavioral response to corridors. Some species use them; some do not. The value of a
corridor depends on its length and width, and thus a linkage of suitable habitat types is not
automatically of benefit to a species. Long thin corridors by definition contain mostly edge
habitat. For many species, this may increase their exposure to predators. At the biogeographic
scale of the study area in south Bahia, we have not found adequate supporting information to
justify the specification of linkages between forest patches as a requirement of the desired
landscape configuration.

If we assume there are two forest patches in a planning region, one larger and one smaller.
There are at least five strategies, according to Possingham et al. (in press) regarding where to
invest in a fixed amount of restoration, each of which increases representation equally in terms
of hectares protected:

1. Make the existing large patch bigger (increases resilience);
2. Make the existing small patch bigger (increases resilience);

3. Link the two patches (increases connectivity with mixed effects on resilience, decreases
redundancy);

4. Make one large patch (increases resilience, decreases redundancy);
5. Make many small, widely distributed patches across the region (increases redundancy).

Each strategy helps achieve some conservation objectives, such as representation across
environmental gradients, connectivity, or viability through larger contiguous habitats. Yet each
strategy alone cannot satisfy all objectives simultaneously. The implications of the strategies on
their relative effectiveness are not always obvious. The implications of various strategies on
other land uses, regional economics, etc. must also be considered. Thus planners must
examine the trade-offs between strategies.

1.2 Basic Operations

TAMARIN is a planning support system to assist in designing a conservation corridor for south
Bahia. The figure below illustrates both the major processing steps in TAMARIN and how the
software fits into the overall planning process. Prior to running TAMARIN, it is assumed that the
required GIS data have been compiled or modeled. Once scenarios have been designed and
evaluated, a decision must be made and the program implemented, with appropriate monitoring
to determine if the desired landscape is being achieved (Ofiate et al. 2000).

Within TAMARIN, the software performs two basic kinds of operations. Steps 1 and 2 in the
flowchart form the design phase of the process, and steps 3 and 4 are the evaluation phase.
These steps will be discussed in greater detail in Section 5.
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1.3 Selection Options

There are many techniques for designing a conservation scenario, and TAMARIN
accommodates several of them as outlined in this section. More details about the mechanics of
selecting planning units for a scenario are provided in Section 5.1.2, this section merely explains
the range of choices.

1.3.1 Select Graphically
You can select planning units interactively using ArcView'’s selection tool, either by clicking on

planning units individually or clicking and dragging the cursor across a rectangular area. This
works well when you have specific sites in mind for a scenario.



1.3.2 Select by Query

Alternatively, you may not know exactly where to restore forest but have a good understanding
of the characteristics of the best locations. Then you can query the attributes of the planning
unit coverage by Boolean logic. For instance, you can query for planning units with attribute
values =, >=, <= a given land value or restoration suitability.

1.3.3 Select by Theme

You or someone else may have created a shapefile (either previously or using the ArcView
graphic tool and converting the graphic into a shapefile) that portrays a scenario. By choosing
the ‘Select by Theme’ option, you can pick this shapefile with the browser and have it select all
planning units that occur within the boundary of the polygons. Note: If the theme has been
digitized externally from the toolbox, it should be in the same projection as the standard themes,
as described in Section 3.

1.3.4 Predefined Scenarios

Some land use options are either useful as benchmarks for comparing with new scenarios or
are obvious strategies that have already been suggested by stakeholders. For these special
cases, we have preprocessed the future (or present) land cover that would result from the
scenario. Thus the planner does not need to follow all the design steps in TAMARIN. Just
select one of the predefined scenarios from the menu and evaluate it. The predefined scenarios
include: 1) the current situation (i.e., 1997 land use/cover), 2) a predefined business-as-usual
scenario (including continued management of existing reserves, see Section 3.2), 3) #2 plus
restoration of cabruca, 4) connect all existing reserves with forest linkages, and 5) an optimal
scenario that achieves the desired landscape configuration at the least possible cost. Normally,
you will not need to evaluate any of these scenarios because we have already done so. The
only circumstance where it would be useful to repeat this evaluation is when the landcover map
is updated or you want to test different assumptions or conservation objectives.

1.4 Outline of the Manual

The rest of the manual is organized as follows:

Section 2 describes the installation process and system requirements;

Section 3 describes the required and optional input GIS themes and their attributes;
Section 4 illustrates the customized menus and buttons created for this application;

Section 5 explains the step-by-step procedures for designing and evaluating conservation
scenarios and their impacts;

Section 6 demonstrates the steps for a hypothetical scenario;

Section 7 outlines how TAMARIN could be modified either for updated GIS themes for Bahia or
for adaptation for use in other corridor projects.
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2. INSTALLATION AND SYSTEM REQUIREMENTS

TAMARIN is an ArcView project file designed to run under ESRI's ArcView software. You may
receive it in one of two forms. If you receive it as a zip file, simply use WinZip or similar
software to unzip the file and place the individual files into their proper folders. To install the
project and associated data files from a CD-ROM, copy the tamarin directory into a new folder
on your hard disk. Select the root folder, then Use the ‘File>Properties’ menu and choose the
Security tab. The top button is for Permissions. Click it. Check both checkboxes—one about
subfolders and one about permissions. Then in the list of users, select Everyone. Pull down
the menu of types of permissions and select Add & Read. This recursively undoes the read-
only permissions created for the CD-ROM.

The pathnames of data files are hard-coded in the project file, so you will need to update them
with the path on your computer. To do this, go to the Exploring window and double-click on the
APR-Tool.exe icon or filename (This helpful program by Nicolo Pitsch can be obtained from
http://gis.esri.com/arcscripts/scripts.cfm if it is not obtained with the Tamarin package). Click the
‘Open’ button and select tamarin.apr as the input project name (Old file). The default name for
New file will be tamarin_new.apr. Change this name if you wish. Click the ‘Replace’ button and
enter the old pathname and the pathname that matches the directory structure where you
copied the files. Click the ‘Check paths’ button to make sure the folders actually exist. Then
press the ‘OK’ button to make the global change in the project file.

)-f:' APB_Tool [1.72] by Nicolo Pitsch Email: nicolo.pitschi@email.ch

Language
Replace paths within ArcView Project - Files £ Close |
elect Archiews Project-File
Open... | Old file: : hioraid00'projects brazilDavidisdss tamarin apr
Mew file: h: hinraid00projects brazilDavidisdss tamarin_new apr

~Feplace paths in new file

Ok | Check paths Replace. .. Directaries. .. I
Old path Rlesw path |;
mzhioraid00projectsbrazilidavidizdssaiz_input! ctamarindgis_input! —
mhioraid00projectsbrazilidavidisdsaigis_inputinfo/ o tamarinigis _inputinfol
m:hioraid00projectsbrazilfdavidisdss! c:tamarind
e hioraid00projectsbrazilidavidisdssinfal o Ramarindnfol
m:hioraid00iprojectsdrazilfidavidizdssioptionss c:tamarindoptions.

m:hioraid00projectsbrazilidavidizdssioptionsinfol o tamarinfoptionsfntal
mhioraid00projectsbrazilidavidhegoover ! o tamarind
m:hioraid00projectsbrazilidavidisdssregionstuffr c:tamarinfregionstuff’

m hioraid00projectsbrazilidavidisdssregionstuttinfo) o tamarinfegionstuffinfol
m:hioraid00projectsbrazilidavidivegcover infaf ctamarindnfol

mhioraid00krojects brazilfdavidisdssigi=_output! o tamarindgis_output! LI




Search and replace |

search Im:a"l:uil:urail:ll:lI:I.-’pn:niects;’l:urazil.-’david.n"sdss j Replace all |
Replace: Iu::a"tamarin j Close |
v From top

After fixing pathnames, double-click on the tamarin_new.apr filename (or whatever you chose to
call it) to run TAMARIN. The default window size for TAMARIN is set at 1000x800 pixels. The
view windows (those with maps) are automatically scaled to fit in this window. If you choose to
resize the application window, the view windows may become too large or too small. Click on
the button with the three dots to resize the view windows to the appropriate size.

TAMARIN requires the following hardware and software:

» ArcView 3.0+ with Spatial Analyst extension

* Microsoft Windows 95/98/2000 or NT

» Some GIS operations on this large data set are very computationally intensive. We
recommend your computer have 128 megabytes of RAM and a fast processor. A high-
resolution display is useful for displaying the graphic and map data.

* The ‘Landscape Configuration’ menu generates several very large grids as temporary files.
We recommend at least 1 gigabyte of available disk space in the partition where TAMARIN

is installed to accommodate these grids. Once the script has executed the large temporary
grids are automatically removed.
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3. REQUIRED AND OPTIONAL INPUT THEMES

TAMARIN is distributed with several GIS themes that are the basis for conservation scenario
design and evaluation. Several additional themes are provided for geographic reference and
visualization. This section briefly describes the required and optional themes. Users may
substitute new versions of any theme. Guidance is provided in Section 7. These substitute
themes must be in the same map projection and datum as the originals. For the Central Atlantic
Forest Corridor Project, all themes have the following ARC/INFO projection properties:

PROJECTION UTM

UNITS METERS

ZONE 24

SPHEROID SOUTHAMERICAN1969

DATUM SAN_C

YSHIFT 10000000 /* FOR THE SOUTHERN HEMISPHERE
PARAMETERS

3.1 Planning units (Required)
This shapefile (cell990m.shp) is used for selection of priority conservation areas in a scenario.

At the regional scale of the Corridor project, it is neither appropriate nor feasible to use parcels
as the basic spatial unit for selection. Maps of parcels do not exist, and the information on
costs, environmental benefits, etc. are too uncertain, both in value and geographic location, to
be reliable at the parcel scale. TAMARIN uses a square grid of planning units that are 990
meters on a side. These are the spatial units that can be selected by various means (see
Section 1.2) for either protection or restoration.

The information used in selecting planning units or in evaluating scenarios is contained in the
attribute table (see Attachment A at the end of this manual for details of the data fields). Fields
of data include: Land_Value, which is the predicted or imputed land value for the planning unit
(i.e., the cost to acquire the land in the unit); Easement_Value , which is the imputed value of
the resource potential of the land without considering the land value (i.e., the minimum cost to
acquire a conservation easement); and Environmental Benefits Index, which is a suitability
score for restoration or conservation based on the current land cover of the unit. World Bank
economists estimated Land_Value by multiple regression hedonic models with variables for soil
properties, land cover, and distance from roads. Besides economic values and environmental
benefits, the attribute table contains fields that can be useful in selection queries, such as the
percentage of a unit with primary forest, the population density, and variables used in the
hedonic models. One field contains our interpretation of whether a unit can be restored as
forest by natural regeneration or not, based on an assumption that this process can only
operate without human intervention (and cost) within 1 km of existing primary forest fragments.

Because there is little experience with conservation easements in Brazil, we are uncertain about
the magnitude of opportunity costs. Consequently, we provide four alternative assumptions
about the opportunity costs that should be paid to landowners as environmental compensation
(or easement value) as an incentive to participate in restoring the corridor. Users can select the
alternative Easement_Value as the conservation intervention. Here are the four alternatives
and their assumptions. In the explanations of the options, ‘actual’ value is the imputed
Land_Value in a unit with its current mix of land cover types. Its ‘value if all forest’ is the land
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value predicted if the unit were all forest and could not be used for agriculture or timber. The
easement value (or opportunity cost) is some proportion of the difference between the two.
Each alternative uses different assumptions about this difference. The value is the sum of the
easement cost for all lands within a planning unit that contain forest or could be restored as
forest. That is, land use such as urban and cover types such as water or mangrove incur no
cost, nor do they contribute to the forest conservation objectives.

 Easement Valuel— We asserted that the easement value was equal to the difference
between the “as is” land value, and half of the “all forest” land value. This assigns a
relatively low opportunity cost to maintenance of primary forest. EV1 ="actual' value —
(value if all forest / 2).

* Easement_Value2—This assigns a zero opportunity cost to maintenance of primary forest,
based on the assumption that current law forbids cutting primary forest (also assumed in #3
and #4). EV2 ="actual' value - value if all forest.

* Easement_Value3—This assigns a zero opportunity cost to maintenance of primary forest
or cabruca. EV3 = 'actual' value - value if (cabruca stays cabruca and everything else is
forest).

* Easement_Value4—This assigns a zero opportunity cost to primary forest maintenance and
a relatively low cost to cabruca maintenance. This is the default easement value for south
Bahia, given the current legal, social, and economic situation. EV4 =.5* (EV2) + .5*(EV3).

A blank User_Defined_Easement field is also provided to allow planners the option of making
different assumptions about the opportunity costs that must be compensated to motivate
landowners to conserve forest. Planners can recalculate this field prior to designing and
evaluating a scenario.

Because spontaneous forest restoration is unlikely beyond approximately 1 km from existing
forest, we attributed an additional cost of R$2000/ha for manually-intensive reestablishment
(Viana et al. 1997) when the Restorable field contains a value of ‘N’. Otherwise, there is no
restoration cost.

There are also alternative assumptions about the Environmental Benefits Index variable. We
have computed six alternative values for this index, based on different assumptions or criteria
about the value of cabruca and/or secondary forest in a unit. The six alternative indices are
described below. The extent of each cover type is also stored in the planning unit attribute
table.

» EBI_Orig—this was the original environmental benefits index we calculated. It gave
greatest weight to primary forest, only gave moderate weight to cabruca if primary forest
was present, and relatively low weight to secondary forest if it was in a matrix with primary or
cabruca, as follows:

Define the function D(x) =0ifx=0

=1lifx>0
let P_primary = percent primary (ie hectares of primary in the planning unit)
let P_cabruca = percent cabruca (ie hectares of cabruca in the planning unit)
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let P_secondary = percent secondary (ie hectares of secondary in the planning unit)
generate:
P_cabprim = P_Primary + P_cabruca
then
EBI_Orig =
5*P_primary +
3 * P_cabruca * D(P_primary) +
2 * P_secondary * D(P_cabprim)

EBI_Cab— EBI_Orig gave no weight to planning units with cabruca without primary forest
interspersed with it. From the methods for mapping landcover, this situation applied to most
units with cabruca and so cabruca generally scored very low. This variation on EBI gives
value to cabruca in any context, while primary and secondary forest are the same as in EBI
as follows:

Define the function D(x) =0ifx=0
=1ifx>0

let P_primary = percent primary (ie hectares of primary in the planning unit)
let P_cabruca = percent cabruca (ie hectares of cabruca in the planning unit)
let P_secondary = percent secondary (ie hectares of secondary in the planning unit)
generate:

P_cabprim = P_Primary + P_cabruca
then
EBI_Cab =

5*P_primary +

3 * P_cabruca +

2 * P_secondary * D(P_cabprim)

EBI_Pref—Our latest (and preferred) variation that modified EBI_Cab slightly. It gives
moderate weight to cabruca if primary or secondary forest is present and to secondary if
either primary or cabruca is present; otherwise, cabruca and secondary receive a low weight

as follows:

Define the function D(x) =0ifx =0
=1ifx>0

let P_primary = percent primary (ie hectares of primary in the planning unit)
let P_cabruca = percent cabruca (ie hectares of cabruca in the planning unit)
let P_secondary = percent secondary (ie hectares of secondary in the planning unit)
generate:

P_anyfor = P_primary + P_secondary

P_cabprim = P_Primary + P_cabruca
then
EBI_Pref =

5*P_primary +

3 * P_cabruca * D(P_anyfor) +

3 * P_secondary * D(P_cabprim)+

1*P_cabruca * (1 - D(P_anyfor)) +
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1 * P_secondary * (1 - D(P_cabprim))

« EBI_Pref LV—this version uses EBI_Pref adjusted by the Land_Value (hormalized by the
maximum land value in the Corridor). This has the effect of highlighting lands that are high
conservation value AND inexpensive. The formula used is:

EBI_Pref LV = EBI_Pref - (( Land_Value / max Land Value ) * EBI_Pref) where
maximum land value is R$242,397.35. If Land_Value = 0 because the planning unit
is in an existing reserve, then EBI_Pref_LV was set to EBI_Pref / 0.01.

» EBI_Core—the previous EBI indices are based solely on he content of each planning unit.
We also include an EBI that accounts for the context of the planning unit as well. Itis
designed to identify potential core areas for forest blocks. First the landcover theme was
reclassified into suitability values adapted from a table developed at one of the PROBIO
workshops. This table rated each cover type for structural complexity, soil conservation,
regeneration potential, and dispersal potential and then aggregated into an overall rating.
Second, the 30 m pixels are summarized over a circular neighborhood 990 m in radius
around each focal pixel using the FOCALMEAN function. Each pixel is assigned the mean
suitability value of its neighborhood. Then the neighborhood values are summarized for
each planning unit, again by calculating the mean and normalizing to a maximum value of
5.0.

 EBI_CORE_LV—this is a variation of the EBI_Pref LV index, except it uses the EBI_Core
index as the numerator instead.

A blank User_Defined_EBI field is also provided to allow planners to make different choices
about the factors of environmental benefits they wish to emphasize. Planners can recalculate
this field prior to designing and evaluating a scenario.

We have created this theme and its summary attributes as part of TAMARIN. You may wish to
use a different spatial unit for designing and evaluating scenarios (e.g., census tracts, or regular
units of a different spatial resolution). TAMARIN asks which theme to use for planning units
during the ‘Define a scenario’ dialog. Simply select your theme instead of the default version we
have provided. However, be aware that your theme must contain the identical set of attributes
as the default theme to prevent errors.

3.2 Business-As-Usual Scenario (Required)

TAMARIN compares conservation scenarios to the current situation and to the land use trend.
This raster theme portrays a forecast of future land cover/use in the absence of conservation
intervention. The modeling framework asks the user which theme to use as the business-as-
usual forecast, and users can create their own (but it should be saved into the Options folder).
In the absence of information on socioeconomic drivers of future land use change, we employ a
simple deterministic model of change, based on the following assumptions (see Table below).

Recent land use trends will continue over the next two decades if conservation
interventions are not applied. Primary forest will no longer be converted to other uses
because it primarily remains on marginal lands and is legally protected. However, it will
continue to be degraded into secondary forest through firewood gathering and other
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resource extraction, hunting, and other human-related impacts. Secondary forest will be
permanently converted to pasture or agriculture except where it is near primary forest, in
which case it will remain secondary forest. Cabruca will be entirely replaced by other
forms of agriculture including sun-grown cacau, coffee, or crops or pasture. Pasture and
agriculture will generally remain, as we assume no spontaneous abandonment and
regeneration of farmland. Bare land is assumed to be a temporary state of agricultural
land that is reclassified as agriculture/pasture for the future. Urban land uses and other
habitat types (e.g., mangrove, wetlands, water bodies, etc.) cannot be converted into
forest and are assumed to remain in their present condition. Similarly, we do not project
changes for restinga and caatinga.

3.3 Restoration Interventions (Required)

This raster theme reclassifed existing land cover/use (Section 3.6 below) into the highest level
of habitat possible if the pixel is in a planning unit that is selected for conservation action. We
assume that restoration or regeneration produces a class we call ‘restored forest’, which will be
similar to secondary forest for the short term, but will eventually resemble primary forest. The
reclassifications applied to the current land cover/use are given in the table below.

After the user selects planning units for conservation intervention, by any of the methods
discussed in Section 1.2, the restoration theme is extracted for those units and then merged
with the Business-as-Usual scenario (section 3.2) for unselected units to predict the future land
cover/use pattern for the scenario.

Table of assumptions about transitions in land use/cover form current to the future without or
with protection/restoration.

Business As Usual Restoration Scenario
Scenario Class Class

Secondary Forest Primary Forest
Secondary Forest if near | Restored Forest *
Primary Forest;
Otherwise Pasture/Ag
Cabruca Pasture/Agriculture
Eucalyptus Plantation | No change

Current Class

Primary Forest
Secondary Forest

Restored Forest
No change

Pasture/Agriculture No change Restored Forest *
Bare soil Pasture/Agriculture Restored Forest *
Restinga No change No change
Caatinga No change No change
Mangrove No change No change
Wetlands No change No change
Water No change No change
Urban No change No change
Non classified areas | No change No change

* If pixel is within 1 km of forest as a seed source, restoration is spontaneous; otherwise a
reestablishment cost of R$2000/ha is imposed.
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3.4 Bioregions
(Required)
The conservation o mff;:g_f;:a us
objectives for the Corridor forast
are to preserve or restore
examples of forest in each
bioregion. This layer was Narthern
derived from a vegetation caatinga
map compiled by Wayt
Thomas and Andre
Carvalho for the Corridor
project, based in part on
their previous research
(Thomas et al. 1998).
There are two formats for
this theme. The vector
shapefile version is used
for visualization. The grid
version is used in sami-docidnons
summary analysis to forest .
compare a scenario with (| wbukito
the bioregional '
conservation objectives.
The bioregions capture the o o a0 40 Kiemet
major patterns of flam eters
biodiversity in the corridor. e
From coast to interior, the Bl Reserves
vegetation grades from
lowland wet forest to semi-
deciduous Forest. The
north to south zonation
recognizes the
biogeographic barriers of
the Rio de Contas and Rio
Jequitinhonhia. Distinct
endemic flora and fauna
occur to the north and
south of both of these
major rivers.

Coasta¥
wetlandd
Fiverihe
syatern

Conptral

Coasta¥
wetlanay
thverine
systerm

Coasta¥
wetighdd
riverine
system

3.5 Prime Farmland
(Required)

Allocation of the best farmland to conservation purposes conflicts with social goals such as self-
sufficiency in food production. In the absence of a map specifically delineating prime farmland,
we use a map derived from Radambrasil’s Potential Use of the Land map (Brasil, Ministério das
Minas e Energia 1981, 1987). This map classified soil and climate attributes into a set of seven
classes (six of which occur in the Corridor project area) and then rated each class for its
potential for agriculture and other land uses. Only one class, called Lavoter, is rated as highly
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suitable for agriculture in the Corridor. We extracted the polygons with this class and converted
it to a grid as a coverage labeled ‘Prime Farmland’. It is used in the summary analysis.

3.6 Paved Road Mask (Required)

TAMARIN treats paved roads as barriers that fragment forest blocks. This grid theme excludes
lands within 210 m of all paved roads when grouping pixels into forest blocks. It is derived from
the shapefile theme of roads described in section 3.9.

3.7 Current Land Cover/Use (Optional)

This theme helps analysts visualize current patterns of land use and land cover. It is not directly
used in the analysis by TAMARIN. The land cover/use theme is the raster image that was
interpreted by Charlotte Landau and Andre Hirsch from 1994-1997 Landsat Thematic Mapper
data. The ERDAS IMAGINE files were first converted to ARC grids for use in TAMARIN and
then mosaicked into a single grid layer. The grid was clipped to the corridor boundary. In the
original version, bare and urban land classes were combined. To segregate these, the 1991
census data were used to identify urban areas (population density greater than 100 people per
km?2) and all bare/urban pixels within these census tracts were reclassified as urban.
Conservation International used older satellite imagery to fill in cover types where cloud cover in
the recent data prevented classification. The classification of cover/use types in the grid are:

Table of land use/cover codes in the GIS layer and corresponding class name.

Code | Class Name
3 | Primary Forest
4 | Secondary Forest
5 | Cabruca
8
9

“Restinga” (Arboreal)
“Restinga” (Herbaceous)
10 | “Caatinga”
11 | Eucalyptus Plantation
12 | Pasture/Agriculture
13 | Bare soil

6 | Mangrove

2 | Wetlands

1| Water
14 | Urban
20 | Non classified areas (clouds, shadow)

This theme can be used to guide selection of planning units in the manual options.
3.8 Existing Reserves (Optional)

This vector shapefile depicts all known nature reserves in the Corridor that was compiled by
INCRA and supplemented from other sources for recently established reserves and major
RPPNs. Area de Protegida Ambiental (APA’s) or Environmentally Zoned Areas were not
considered protected for biodiversity as they are managed primarily for tourism. It is assumed
that reserves are and will continue to be protected. This theme is included as a visual aid for
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selecting additional sites to expand/buffer (increase resilience) or to complement the existing
reserves (increase representation).

3.9 Roads (Optional)

Roads are important geographic features for orienting a user in the map display. They also
have significant impacts on land use, land value, and habitat value. Therefore, there is one
shapefile version of roads for visualization and a grid version that has been buffered by road
type. The latter theme is used in calculating edge effects on forest habitat and separates tracts
of forest into smaller fragments when determining the number of viable fragments. Charlotte
Landau had topographic maps (1:100k) digitized, and then she updated them with newer paved
roads.

3.10 Municipios (Optional)

These are the basic political units of the Corridor. They are provided here as base map features
for orienting the planning team in creating and evaluating scenarios. The theme table contains
many attributes from the Census of Agriculture, which can be displayed if desired through
standard ArcView tools such as the Legend Editor.

3.11 Cities (Optional)

Cities are also useful landmarks for orienting a planning team. A subset of all populated places
with at least a population of 25,000 people was extracted and annotated with their names.
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4. TAMARIN's CusTOMIZED GRAPHICAL USER INTERFACE
We customized ArcView to make TAMARIN more useful for corridor planning. Several menus

were added in the ViewGUI (see Section 5) and a series of buttons were added to the ViewGUI
button bar.

B F=IG]

The hut button always resets the current working directory to the root directory of TAMARIN.
This is useful if you have used the browser to navigate to other folders and are having trouble
navigating back (or if TAMARIN is having trouble finding files).

The dollar sign ($) button can be used when selecting planning units to discover how much the
selected units will cost. You can see what proportion of your budget is left or how much you
have exceeded it. This only works with the original planning unit theme, not with the new
shapefile created of the selected units following the budget constraint step.

The downward arrow (or horizontal lines that get narrower towards the bottom) is used to close
all table windows. TAMARIN can create many summary tables. When you are done reviewing
them, click this button and it will automatically close every open table window. The tables are
not lost or deleted. They can be reopened from the ‘Project’ window in the ‘Tables’ section by
double-clicking on the name or clicking once and clicking the ‘Open’ button.

The ‘3 dots’ button resizes the View windows according to the size of the TAMARIN window.
This can be useful when starting TAMARIN for the first time on a different computer with a
different screen resolution or when you simply resize the application window.

The Paper Clip and Redo buttons are used to save and recover a set of selected planning units.

This guards against accidentally unselecting units that you have chosen manually and that
would be tedious and frustrating to select again (see Section 5.1.2).
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5. ANALYSIS PROCEDURES

TAMARIN contains two categories of analysis procedures. You use the first category to design
your own scenario and the second to evaluate that scenario.

5.1 Procedures for Designing a Scenario

The procedures for selecting are divided into three sequential steps. First the planner defines
the parameters of a scenario in a form or dialog box. Next the planner selects planning units for
the scenario by one of the methods described in Section 1.2 above. The final step allows a
budget constraint identified in the scenario definition to be applied to the selection. These three
steps are described in detail next.

5.1.1 Define a scenario

Each scenario will have different parameters. The first step is to
define what those parameters will be for a particular scenario.
From the ‘Select sites’ menu, choose the first option, labeled

Ewvaluation  Fi

ar | (]

Siellze! Pl il og) | it ‘Define a scenario’. This opens up a series of dialog boxes or
Constrain by Budget forms with a combination of text lines for typing names or values,
Fredefined Scenarios scrolling lists of files to select from, and radio buttons for selecting

between mutually exclusive options. The results of this dialog are
written to a text file to document the scenario, and some of the results are used in subsequent
generation and analysis of the scenario.

£} Scenario Parameters Window

Enter Scenana Parameter

Enter zcenanio name [up to B characters] I Budghl

Mame of planner Itamarin

Enter budget [leave blank if none] I ROO00000

Comments | budget constraint of B0 million reais

Cantinue | Cancel

Each scenario is given a unique name in the first text box. Type a name that helps identify the
scenario but is no more than 6 characters long. Besides being written to the scenario text file,

this name is used in naming many of the new themes, tables, and charts that are generated by
the analysis procedures.
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The second text box asks for the name of the person (or organization) who created the
scenario. This is written to the scenario text file for documentation, along with the current date,
which is determined automatically by the software.

The budget for this scenario can be set in the third text box. The default value is to have no
budget constraint. If you enter a value, in Brazilian Reais, this amount constrains the number of
planning units for which a conservation intervention can be applied. Setting a budget lets you
compare a single strategy with different budget levels or different strategies with the same
budget. If a budget constraint is applied, it may reduce the number of planning units that you
initially select (see Section 5.1.3 below for details). Click ‘Continue’ to proceed to the second
dialog window.

& Scenario Parameters Window 2

Choose the assumptions for this scenario

= Pay full land walue
+ Pay easementwvalue

" Pay other incentive offer

kdinimum wiahle hahitat size (ha) | 10000
Maximum gap crossing distance (meters) | 1000
Depth of edge influence (meters) | 300
Mumber of representations per region | 2
Accept scenario Cancel

There are three radio buttons in this second dialog for choosing the conservation intervention to
be used in this scenario. The first uses land acquisition. If the box is checked, the full purchase
price of the planning unit will be assessed against the budget. If the second button is checked,
the selected planning units will be conserved through some form of conservation easement. In
that case, the cost of conservation action only includes payment of the opportunity cost to the
owner. You will be asked later to select the alternative estimate of opportunity cost/easement
value. The third radio button indicates a scenario where a fixed payment is offered for
easements. Selecting this button triggers an input message window to specify the amount of
the payment in reais per hectare.

The first three text boxes control how forest habitat units are defined in the analysis procedures,

including representation goals. The first box sets the minimum size (in hectares) of a block of
primary and/or restored forest for it to be considered viable for maintaining native plant and
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animal diversity, assuming no immigration of individuals or propagules from outside the block.
This is a difficult number to determine because it depends on the taxonomic group one is
considering. Thus we have tentatively allowed this to be set as a variable in each scenario and
documented in the scenario text file. The default is currently set at 10,000 hectares based on
modeling by Adriano Paglia of the probability of extinction for the yellow-breasted capuchin.
Note that Gascon et al. (2000) predict serious degradation from edge effects for forest blocks
smaller than 5000 hectares, whereas Chiarello (2000) sets this threshold at 20,000 hectares.
The second of these parameters specifies the maximum distance (in meters) that species or
propagules can travel across agricultural land use to reach nearby fragments. Fragments that
are closer than this maximum distance, set at a default of 1000 m, are treated as being part of
the same functional block. It is the block that is compared to the minimum viable habitat size.
The third text box asks you for the maximum distance (in meters) that you believe human-
caused effects propagate from the edges of forest patches into their interior. The default value
for Depth-of-edge-influence is set at 300 m (Gascon et al. 2000) although this depends on the
type of disturbance and its ecological impacts. This distance is used in calculating the amount
of core versus edge forest in a scenario.

The last text box sets the number of separate habitat units needed in each bioregion to achieve
the desired conservation goals for the scenario. The default value is set at two habitat units per
bioregion.

When you have finished defining the scenario, click on the ‘Accept scenario’ button at the
bottom of the dialog window. You may also click on the ‘Cancel’ button to leave the dialog
without saving your choices.

After clicking the ‘Accept scenario’ button, you will be asked to select three themes for the
analysis. The first theme contains the set of planning units from which to select a scenario.
Normally you should select cell990m.shp unless you are substituting your own planning unit
theme. The second theme depicts your forecast for the future in the absence of conservation
intervention (the business-as-usual scenario as described above). The third theme is your
choice for the restoration grid, to be used for planning units that are selected for conservation
action. TAMARIN will display a scrolling list of themes and ask you to select which theme to
use for the three types of theme. Simply click on the theme name and click ‘OK’. The default
business-as-usual theme is called ‘BAU’ and restoration theme is called ‘Restore’. You may
substitute your own theme for one or both of these provided your theme meets all the format
and data requirements of the default themes.

-‘7:' Pick planning unit theme ' il
Directary: |n:::".,dEwid‘.,braziI".,sdss‘.,gis_input Ok |
= o - |
E incra_assentamentos = dawid —lance
@ incra_uc.shp [= brazil
& municipios [= sdss
B paved_roads.shp _ _
& popplaces 0 bioregionsard & Directories
B popsuml.shp 3 incra_grd  Libraries
M reseres sho ll "1 infn ll
Data Source Types: Ditives:
|Feature Data Source | ||::: |
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“ Pick business-as-usual grid

Diren:tu:ury: ACaWICRraZINsa 550 pR1aNn: QK. |
E bau = = o = C | |
E restare = danid el

= brazil
= sdss
& options
1 info &+ Directories
= —| ¢ Libraries
Diata Source Types: Drives:
| Grid Data Source [ B =]

After prompting you for the themes to be used in the analysis, TAMARIN allows you to choose
among other alternative assumptions. The first choice is to select the Environmental Benefits
Index variable in the planning unit theme. We have computed six alternative values for this
index, based on different assumptions or criteria, plus one you can compute yourself. You will
be shown a scrolling list and asked to select the name of the field you wish to use. The seven
alternative indices are shown below and are described in section 3.1.

& PickEBI script

Click on field with wour choice of
emviranmental benefits index

canc
EBEl_Core
EBI_Pref_Lv
EBl_Core_LY
EBI_Cah

EBI_Orig
User_Defined_EBI

—
-
——

There are also several alternative assumptions about the opportunity costs that should be paid
to landowners as environmental compensation (or easement) as an incentive to participate in
restoring the corridor. If you selected Easements as the conservation intervention, you will next
be asked which of four easement value assumptions you wish to apply in the scenario. The four
alternatives are shown below and are explained in Section 3.1.
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A

J PickEasement¥alue scripk

Click on field with the preferred easement
value

Easement_“aluel
Eazement_“alue?
Easement_“aluel
User_Defined_Easement

5.1.2 Select planning units

Section 1.2 described the three methods for selecting planning units for a conservation
scenario. This section provides greater detail on how the selection is performed in TAMARIN
for each method. The selection methods do not consider the budget constraint. The user may
select as many planning units as desired. Applying the budget constraint that was identified in
the Scenario Dialog in Section 5.1.1 occurs in the third step, described in Section 5.1.3.
Therefore, the planning units selected in this step form only a starting or tentative set. In all
selection options, the selected planning units are highlighted in yellow in the Analysis View
window.

iI Selection options menu

-‘f_:-’ Selection Options

Graphical selection—In this selection
method, the planner uses the ArcView
Select features tool (see graphic of
raphically ]| Cancel tool button below) to select planning
hit units with the cursor based upon his or
' her judgment about priority locations
for conservation. Select the ‘Select
graphically’ option in the ‘Selection
options’ menu. Clicking on a single
planning unit in the Analysis View
- window will select that unit. Clicking
and dragging the cursor with the left
mouse button depressed will select all
units within the rectangle drawn by the planner. To select additional units, hold down the Shift
key while clicking or clicking/dragging with the cursor. Selected planning units will be
highlighted (in yellow). To unselect planning units, hold down the Shift key while clicking on
individual planning units. If you wish to start over, go to the Theme menu and select the ‘Clear
Selected Features’ option. Alternatively, you can use the ‘Clear Selected Features’ tool on the
toolbar. Then you may begin selecting units again. Note that planning units will be selected if

Choose a selection method Ok,

|Selectg

melect by query
Select by theme
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the rectangle intersects any part of the unit, not just those that are completely contained in the
rectangle.

The ArcView ‘Select features’ tool.

At any time, you can check on the current cost of the selected planning units by clicking on the
‘$’ icon on the button bar (see Section 4). This computes the appropriate costs (for land or
easement purchase or incentive offer as appropriate) of all selected units. This informs you of
whether you have already exceeded your budget or can select additional units.

It is relatively easy to forget to use the Shift key to add planning units to the set you previously
selected. This has the effect of unselecting those and only selecting the new units. To guard
against this accidental loss of your work, TAMARIN provides a means of saving what you have
selected in a file, and in case of accidental loss, of recovering what you had selected. The
Paper Clip button saves your current selection (writes it to the savepu.dbf table). The Redo
button to the right of the Paper Clip uses that table to select the units that you had saved (see
Section 4).

e Select by Query—
£ Cell990m.sh - ><| - .
= s (=] ArcView has built-
Fields Yalues in procedures for

[Land_walue] ﬂ = |

[E azement_* aluel]

[E azement_* alue]
=]

attributes of the GIS
database and

not selecting those
planning units that
match the Boolean
search criteria. For
[ [Pfor_ha] »= 30] and [[E asement_%alued] < 20000 ) - Few Set I instance, in a query
of planning units
Add Tao Set | with at least 30 ha
of primary forest

v| SelectFromSet | | AND an easement
value less than
20,000 reais per
planning unit, those units that satisfy both conditions would be selected. Select the ‘Select by
guery’ option in the ‘Selection Options’ menu. This will open a dialog window in which you can
specify the selection criteria. The list on the left side of the dialog box contains the set of
attributes for the planning units. For our example above, you would double-click on the
‘Pfor_ha’ attribute, which would then appear in the query window in the bottom of the dialog box.
Next, single click on the *>=" operator symbol in the middle of the dialog box. Then type the
number ‘30" in the query window. To add the second criterion, single click the ‘AND’ symbol in
the middle of the dialog box. Next, double-click on the ‘Easement_Value4’ attribute in the left
window, followed by the ‘<’ symbol. Type ‘20000’ (no commas) in the query window and click
on the ‘New Set’ button. Use the ‘New Set’ button if these are the first units you are selecting
for this scenario. You could now add additional units with another query if you wish. For
instance, you may wish to add units where cabruca is at least 30 ha and the same easement
value limit. Select the text in the lower window and press the backspace key to delete it. Make
another query, but this time, press the ‘Add to Set’ button. Now you can refine your selection by

|3ﬂ_d, Fe querying the

[E azement_* alue3]
[E azement_* alued]
[Jzer_Defined E azen

[Fe-Establishment Cod ™
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adding another criterion. For instance, you may only wish to select units from your previous
selection that are not densely populated. Clear the query in the lower window again and put in
your new query, e.g., [Population] < 15. ‘Select From Set’ will then only select a subset of
planning units that satisfy the current query from the set that was previously selected. You can
also use the graphical selection tool to further refine your choice by adding or removing
individual planning units from the selected set. (DO NOT USE THE ‘Selection Options’ MENU
AGAIN, HOWEVER, OR THE PREVIOUSLY SELECTED UNITS WILL BE UNSELECTED).

Select by Theme—If a stakeholder has already created an ArcView shapefile that represents a
conservation scenario, you may use that shapefile to select planning units for evaluation. Select
the ‘Select by theme’ option in the ‘Selection Options’ menu. You will be prompted to identify
the shapefile in a browser dialog. Navigate to the shapefile’s folder (the browser will begin in
the current working directory), select it, and click the ‘OK’ button. This theme will be added to
the Analysis View window and will be overlain on the planning unit theme. Planning units that
are completely contained within the areas in the shapefile will be selected. (Currently no option
is provided for other intersection options, e.g., ‘Intersects’ that selects if any part of the planning
unit is within the shapefile area.) You can also use the graphical selection tool to add or remove
individual planning units from the selected set. (DO NOT USE THE ‘Selection Options’ MENU
AGAIN, HOWEVER, OR THE PREVIOUSLY SELECTED UNITS WILL BE UNSELECTED).
This selection option would also be useful to refine a scenario that you have previously
evaluated. Use the shapefile produced for the earlier scenario as the theme to select by, then
modify the selection by further adding or selecting from the initial set.

5.1.3 Constrain by budget

ﬁl To this point, the planner has

selected planning units based on
their attributes without regard to
0 Total Land “alue of Selected Flanning Units: the total cost. It is possible that the

Fi$178.245.636 total cost of the initial scenario

exceeds the budget specified in
the scenario definition step
(Section 5.1.1). Itis possible at
this point to check the total cost,
based on the selected payment method, by clicking on the $ tool, which displays the sum in a
message box as shown here. Selecting the ‘Constrain by Budget’ menu, TAMARIN checks if a
budget limit was set. If not, it gives you an opportunity to add one now. If you did set a budget
limit, the planning units are sorted either by their land value or easement value attribute (as
appropriate) in ascending order or by your preferred environmental benefits index in descending
order and sums the appropriate costs (land value, easement value, or incentive offers) until the
budget constraint is reached. Thus the procedure selects either the least expensive units or
those with the greatest relative suitability for restoration or conservation for the given budget.
The choice of which cost to use is based on your selection of whether to purchase land or
easements or pay incentives in defining the scenario (Section 5.1.1). Planning units are then
selected from your initial set until the budget is exhausted. After running this step, a new
shapefile named after the scenario name will be created and added to the Analysis View. This
shapefile will only contain the selected planning units that do not violate the budget constraint
and is used in the evaluation procedures described in Section 5.2.
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TAMARIN reports the reduction in the number of planning units as a result of imposing the
budget constraint.

‘f_:-' Budget constraint results—SortPol ;' X |

selected

o The budget constraint reduced the number of
planning units from 7028 to 1203

5.1.4 Predefined scenarios

This menu provides options for evaluating baseline scenarios where selection of planning units
is not required or is implicit in the scenario itself. Currently, we have provided for five predefined
scenarios: 1) the current situation, 2) the business-as-usual scenario (including continued
management of existing reserves), 3) #2 plus restoration of cabruca, 4) linking existing
reserves, and 5) an optimal scenario that achieves the desired landscape configuration at the
least possible cost. Run the ‘Define a scenario’ menu first but do not specify a budget. The
Current Situation scenario simply evaluates the 1997 landcover theme in terms of landscape
configuration. There is no need to select any sites nor constrain by budget or summarize
solution. This is also true for the business-as-usual scenario. For #2, you can specify the
business-as-usual grid to be used during the ‘Define a scenario’ dialog. The restore cabruca
scenario automatically selects units in which cabruca covers at least 50 ha. In the linking
reserves scenario, the linkages were determined by the highest cumulative path of habitat
suitability (Environmental Benefits Index), analogous to a least cost path. The optimal scenario
option allows you to evaluate one of the scenarios generated by an optimization model
developed by Dr. Richard Church at the University of California, Santa Barbara, as a benchmark
for comparison to other scenarios (for details on this model and the benchmark scenarios that
were generated, see Stoms and Davis 2001). You will be directed to run the ‘Constrain by
Budget’ and/or the Evaluation procedures as appropriate.
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5.2 Evaluation Procedures

Once the scenario parameters have been defined and the set of planning units has been
selected, the next group of procedures perform the evaluation of the scenario, including the
forecast of future land cover/use (Section 5.2.1); a summary of the economic and environmental
effects(Section 5.2.2); a series of landscape indices characterizing the resulting landscape
configuration relative to the conservation objectives(Section 5.2.3); and preparing and printing a
summary map the scenario(Section 5.2.4).

File Management Help

Summarize Scenario Solution
Landscape Configuration

k|

Frint map of fragments -

Show current scenario textfile
Show a scenatio texdlile

5.2.1 Forecast future land use

This analysis step combines the data from two grids to create a future land use forecast for the
scenario. The two grids are: 1) the restoration theme for selected planning units, and 2) the
business-as-usual scenario for the remaining lands. TAMARIN merges those two grids to
create a future land use forecast grid that is added to the Analysis View window.

Here is the processing logic used to create the theme of future land use:
Was the planning unit selected?

If yes = Restore option as described in section 3.3 (or your own version)
If no = BAU as described in section 3.2 (or your own version)

This theme is given the name of the scenario that you entered in the opening dialog. The
legend is very similar to the Landcover theme, except 1) the cabruca and bare land classes are
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not used (they either become restored forest or agriculture/pasture land depending on the
scenario), and 2) a restored forest class is added. Simply select the ‘Forecast Future Land
Use’ option from the ‘Evaluation’ menu. This newly created grid is used in the remaining
evaluation steps.

5.2.2 Summarize scenario solution

It is not enough to make a map of future land use, it is also necessary to derive some summary
measures about it that can be compared to other scenarios, to the current land use, to the
business-as-usual scenario, and to the conservation objectives. Simply select the ‘Summarize
Scenario Solution’ option from the ‘Evaluation’ menu. TAMARIN computes the summaries and
prints them to a series of tables and/or to a text file. In all the summary tables, the scenario
being evaluated is highlighted in yellow and “promoted” to the top row of the table. The first
table summarizes total scenario cost. Even though you specified whether to pay land or
easement value or an incentive offer, the summary table lists totals for all three types plus the
amount needed for forest reestablishment costs in units beyond the seed range from existing
forest. The easement value total is based on your choice of assumption about easement
values/opportunity costs in the ‘Define a scenario’ step. The second table lists the percent of
land use/cover type in the scenario for the types that can change between scenarios. That is,
the mangrove, wetlands, caatinga, restinga, water, urban, and eucalyptus types are not shown
since they are assumed to remain constant in all scenarios. Therefore, the percentages of land
use/cover types listed in the table will not sum to 100%. The third summary table gives a similar
breakdown of land use/cover types except only for prime farmland. The scenario text file gives
additional summary values such as the average/maximum/minimum of the Environmental
Benefits Index (again based on your choice of index), minimum and maximum land and
easement values, the number of units selected (and that do not exceed the budget), the net
change in area and percent change in land use types from the current (1997) landcover, and the
regional breakdown of cover types in percentage.

5.2.3 Landscape configuration

The desired future landscape configuration is defined not just to achieve a target area of primary
and restored forest in the Corridor but to do so in a number of relatively large, contiguous blocks
of forest habitat with a large proportion in core or interior forest and a small amount of edge.
The ‘Landscape Configuration option on the ‘Evaluation’ menu computes a number of
landscape indices, including the size of the largest forest fragment, the total area of primary and
restored forest, the number of forest fragments, the frequency of size classes of fragments (0-
200 ha, 200-500, 500-1,000, 1,000-4,000, 4,000-10,000, and > 10,000 ha), the number of
fragments that are larger than the minimum habitat size specified in the opening dialog (Section
5.1.1), and the area and percentage of forest that is in core versus edge habitat. These results
are written to a set of tables and/or to the scenario text file.

The ‘Landscape Configuration option processes the following steps (see graphics below for an
illustration):

1. Extract the forest pixels from the Future land use theme for the scenario (primary and
restored forest only)

2. Expand from this set of pixels by half the gap-crossing distance (to determine which
patches are functionally linked)
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2 Land Use by Scenario
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Izland 1.5 1.E 125 0.0 767 =]
Current 2.q 0.0 1E6.5 11.6 55.4
Bal 0.7 0.4 13.8 0.0 773
Cabruc 0.7 10.E 13.7 0.0 E7.1
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@ Land Use in Prime Farmland by Scenario [Hi=l E3
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Island 0.0 0.2 37 0.0 3041 -
Curent i 0.0 165 116 55
Cabiuc 0.0 245 36 0.0 BE.1
T 35 35 0.0 87.1
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Summary tables with the scenario being evaluated highlighted in yellow.
Mask out paved road corridors as barriers to clustering pixels into habitat blocks
Use the RegionGroup command to aggregate pixels from #2 into clusters

Extract forest pixels in #3 by cluster, giving them unique numbers for each fragment and
assess size-frequency (theme added to Analysis View, colored by the size of fragments)

Expand agricultural and urban land use pixels by the edge distance into fragments to
identify edge vs core pixels. Forest adjacent to mangroves, wetlands, other native
habitats, or secondary forest and eucalyptus plantations are not considered edge. That
is, we are only concerned with anthropogenic edges here (theme added to Analysis
View, colored by edge pixels (pink), primary forest (dark green), and restored forest
(bright green)

Select fragments from step #5 that exceed the minimum viable habitat unit size (theme

added to Analysis View, colored by unique ID number of the habitat unit), and determine
largest fragment size
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8. Summarize number of these fragments in each bioregion (not shown)

9. Summarize number of these fragments that have more than 1000 ha of primary forest

(not shown)

Example of processing steps in Landscape Configuration analysis.

Scenario future land

Step 1-Extract forest

Step 2-Pixels within

Step 3-Mask out

use pixels gap-crossing distance paved roads (black
(shades of red) lines)
/

J
X
P

Step 4- Regiongroup
of clusters of
contiguous pixels
within gap-crossing
distance

J
(
(
!

Step 5- Extract forest
fragments from
clusters

Step 6- Core (green)
versus edge (pink)
pixels adjacent to
agriculture and urban
pixels

¥

Step 7-Select viable

habitat units (greater

than 10,000 hectares
in size)
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Summary tables from steps 5 and 8 in Landscape Configuration analysis.

5.2.4 Print map of fragments

This option compiles the maps from the evaluation of the scenario and organizes it into a
printable page using ArcView'’s built-in layout functions. The script assembles a layout
document that contains an 8.5 x 11 inch map of the forest fragments larger than the minimum
size. The report page is automatically formatted for you when you select the ‘Print map of
fragments’ menu option. You can then use the ‘File=>Print’ menu to send the page to a printer
or print it to a file or the ‘File>Export’ menu to export the layout to a graphic format.
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5.3 Scenario Outputs

TAMARIN creates several different types of outputs. One output is a text file containing the
basic information about the scenario. It also generates a future land use grid with the name of

the scenario, as described in Section 5.2.1.
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5.3.1 Scenario text file

The scenario text file contains a description of the scenario (e.g., name, date, business-as-usual
and restore scenario names, budget constraint, minimum habitat unit size, etc.). This file is
created when you select a scenario name in the opening dialog for defining the scenario. It is
given the name <name>_scenario.txt where <name> is the name you assigned in the dialog.
For example, the textfile for the scenario in Section 6 contains the following:

Scenari o Name: exanpl

Created by: stons

Date Created: April 6, 2002

Conment s: exanpl e scenario for user manual
Pl anni ng Units Thene: Cell 990m shp

... Input Paraneters from Scenario Dial og...accept Scenari o scri pt
Budget Constraint: 30000000
Mn Viable Habitat Size (ha): 10000
Max Gap Crossing Distance (m: 1000
Nunber of Representations per Region: 2
Fut ure Forecast: bau
Restorati on Option: restore
Conservation Intervention: |ncentive
I ncentive Offer: 200
Envi ronnental Benefits I ndex: EBI_Core
Easement Option: Easenent Val ue4

...Sel ection Method...chooseSiteSel ector
Sel ect by query

...Statistics for Selected Planning Units...Summarize solution script
Units prioritized by: Environmental Benefits

Number of units selected: 1539

Total Land Val ue: R$35817221.7

Mean Land Val ue: R$23273.0

Maxi mum Land Val ue: R$69677.3; M ni mum Land Val ue: R$595. 4
Tot al Easenent Val ue (based on Easenent Val ued): R$4874218.0
Mean Easenent Val ue: R$3167.1

Total Incentive Ofers: R$29993508. 0

Tot al Reestabli shnment Costs: R$0.0

Esti mated Total Popul ation Affected: 13,140

Mean EBI (based on EBI _Core): 4.7

Maxi mum EBl: 5.0; MnimumEBl: 4.5

... Future Land Cover Totals...Summarize solution scri pt

Cover Type ad Area (ha) Future Area (ha) % Change
Primary Forest 651433. 3 153725. 0 -76.4
Secondary Forest 1224469. 4 883750. 9 -27.8
Past ur e/ Ag 3234511.9 5729561. 4 77.1
Rest or ed For est 0.0 80358. 7 NA
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... Representation of Land Cover By Bi oregion...Sumarize sol ution script
Bi or egi on Pri nFor (% SecFor (% Rest For (% Cabruca (%

Coast/ Wet | and/ Ri ver 0.4 15.7 0.1 0.0
Central Low and Forest 2.4 7.8 0.8 0.0
Nort hern Lowl and For est 2.2 12.3 0.3 0.0
Central Seni-deci duous Forest 1.6 14. 3 1.8 0.0
Sout hern Tabul ei ro For est 5.4 13.5 2.4 0.0
Sout hern Seni - deci duous Forest 0.6 9.4 0.3 0.0
Nort hern Sem - deci duous Forest 0.0 8.7 0.0 0.0
Nort hern Caati nga 0.0 0.0 0.0 0.0
Central Tabul eiro Forest 4.0 20. 2 0.8 0.0
Tot al 2.1 11.9 1.1 0.0

...Representation of Land Cover |In Prine Farm and...Sunmarize sol ution
scri pt

PrinmFor(% RestFor(% Sec For(% Cabruca (% Agriculture (%

0.0 0.2 3.6 0.0 90.4

...Landscape Metrics...Landscape Metrics script

The total area of core forest will be: 196678.7 hectares
Primary core forest will be: 69.2 %
Restored core forest will be: 30.8 %

The percent of core forest will be: 84.2%
The percent of edge forest will be: 15.8%
The ratio of edge to core forest will be: 0.2 : 1
The | argest forest fragment is: 24269 hectares
The total area of core forest in viable units will be: 111131 hectares
There are 7 viable fragnents |arger than 10000 hect ares
Nurmber of viable fragments with at | east 1000 ha of primary forest = 7

There are two options for viewing scenario text files under the ‘Evaluation’ menu. The ‘Show
current scenario textfile’ opens a text window with the results for the scenario you named in the
latest Scenario Dialog. If you would like to view text files from other scenarios for comparison,
choose the ‘Show a scenario textfile’ option. This will prompt you for the name of a textfile from
a list of all such files in the current working directory. Select a filename from the list and click
the ‘OK’ button. A window will open on the screen. Click the X’ box in the upper right corner to
close the window.

5.3.2 Future land use scenario grid

For each scenario, a new ARC/INFO grid is created showing the land cover/use that is forecast
based on the selected planning units, their specified conservation intervention, and the
business-as-usual scenario for unselected units. This grid is given the name of the scenario
and is saved permanently. Other themes may be created in the analysis procedures, but these
are temporary files that are not automatically saved. If you look in the ‘Theme->Properties’
menu, you will see these grids described as ‘Temporary’. Once you exit from TAMARIN, these
themes will be deleted from memory unless you explicitly save them. To save them
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permanently, make the theme active, go to the ‘Theme’ menu, and select ‘Save data set...".
You will be asked for a filename for this theme. The themes properties will now identify this as a
‘Permanent’ theme.

These grids will be automatically saved if you save the project file (under ‘File->Save’, or
clicking the ‘save’ icon). In this case, however, the files are given their temporary names, such
as GRID33, RCLSS4, and similar uninformative names. Therefore, it is recommended that you
explicitly save them with meaningful names if you wish to keep them.

5.4 File Management

TAMARIN potentially creates a large number of temporary grids and shapefiles. The ‘File
Management’ menu has been provided as a simple method for deleting unnecessary themes
from the folder.

There are two options under this menu: deleting grids and deleting shapefiles. They work in
essentially the same way except that they only list the files of the appropriate type to be deleted.
Click on one of the options. TAMARIN opens a dialog window that lists the themes (grids or
shapefiles) in the root folder. You can navigate to a different folder if desired. To delete old
themes, click on its name and then the ‘Delete’ button. The theme cannot be deleted if it is
currently being used in TAMARIN, such as being displayed in a view or as a table. In such
cases, click ‘Cancel’, delete the themes and tables from the TAMARIN project, save it again,
and then try deleting the themes through the ‘File management’ menu.
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6. CREATING A SCENARIO—AN EXAMPLE

In this section, we illustrate the process for creating and evaluating a hypothetical scenario,
following the steps described in Section 5. The example scenario is based on an economic
incentive, where we assume a flat price offer is made rather than paying fair market easement
value, and seeing which landowners are likely to accept it.

Let us assume some purchasing authority offers to pay environmental compensation for
properties with specified characteristics or within specified zones. Let us further assume that
the authority has a fixed budget. The authority publishes a formula that assigns an
environmental benefit index (EBI) to each candidate unit. We cannot predict which landowners
will choose to participate so let us simply say that any eligible units can be selected if the
offered price is at least as high as the opportunity costs as estimated in the easement values.
The authority ranks planning units by EBI and purchases from highest EBI to lowest until the
budget is exhausted. How can this policy be demonstrated in TAMARIN?

Begin by defining the scenario and set the budget to R$30,000,000. In the second dialog box,
select the ‘Pay other incentive offer’ radio button. We will accept the defaults for the desired
landscape configuration. We select the ‘EBI_Core’ benefits index option and set the incentive
payment offer at R$200 per ha. To identify eligible units, we use the ‘Select by Query’ menu
option. We first query for units that are restorable without paying reestablishment costs
([Restorable] = “y”) and ‘Select from Set’. EXxisting reserves are already protected so we can
exclude them from the candidate set by querying ([InReserve] = “n") and ‘Select from Set’. We
next select planning units outside the coastal bioregion where primary forest is not an issue.
([Bioregion_Name] <> "Coast/Wetland/River"). To identify potential sellers, we must limit the
units to those whose opportunity costs are less than R$200 per ha, so we query for
([Easement_Value4] <= 19602) (i.e., R$200/ha * 98.01 ha/unit = R$19,602/unit) and ‘Select
from Set’. This leaves us with 19,275 units out of 77,010 total and a cost of R$364 million if we
pay R$200/ha. In contrast, if the authority were only paying the estimated easement value (#4),
the total cost would be R$233 million. This still far exceeds the budget so we further reduce the
set of units by applying the ‘Constrain by Budget’ menu option. We elect to sort by the
environmental benefits index (EBI_Core) in descending order and allocate funds until the
budget is exhausted. This reduces the selected set to 1,539 units. The scenario summary
indicates that these units could actually be purchased for only R$36 million and the easement
value is only R$5 million. Thus there is a high cost of a flat incentive payment compared to
other incentive mechanisms. This instrument, however, only achieves the conservation
objectives in two of the seven bioregions, because the selection process chooses many
relatively small, isolated fragments. Further refinement would be necessary to produce the
desired clumping of fragments. Additional results of this scenario can e seen in he textile in
section 5.3.1.
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7. DATABASE REVISIONS OR SUBSTITUTIONS

The TAMARIN planning support system, based on ArcView and customized with AVENUE
scripts, was designed specifically for corridor planning in south Bahia, Brazil, and to address
specific research questions of interest to the research team. As a result, the GIS data and
AVENUE coding are tightly coupled. It is highly likely that some of the themes will be updated
during the remainder of the planning process. Therefore, there may be a need to replace or
update themes or attribute data in TAMARIN. This section describes how to do so. Others may
wish to adapt TAMARIN for other corridor projects in other regions of the world. TAMARIN will
require some modifications. The second part of this section outlines some of the general
changes in data and in the coding of AVENUE scripts themselves to be used in corridor
applications in other parts of the world.

7.1 Updating Bahia Data

TAMARIN was developed with the GIS database that existed at the time. Some of the data
layers were draft versions or needed some fine-tuning before final analysis. At least four types
of revisions may be involved if revised themes are produced in the future: substitution of a
newer version of a theme (e.g., a final land cover theme that fills in cover types where clouds
obscured the ground in the initial version), substitution of a new value for an attribute (e.g.,
revised model results for predicted land value), replacement of derived GIS themes as a result
of revision in the primary data layer (e.g., updating the business-as-usual scenario which is
derived from the landcover theme), and creating new themes as alternatives (e.g., creating your
own business-as-usual scenario based on different assumptions about the future).

The safest method to replace a new version of a theme is to delete the Bahia themes in the
TAMARIN view windows. Make a theme active by clicking on its legend in the table of contents.
Delete by using the Edit>Delete menu. Save the project file and then delete (or rename) the
original theme from the folder by using the ‘File Management’ menu as described above or by
using ARC/INFO commands. Also using the file management dialog, copy the new version to
the folder and give it the same name as the original version. Then use the View—>Add Theme
menu to add the new version to the appropriate view. While it is also possible to simply swap in
the new version in the folder while TAMARIN is closed, so that the new version will be used the
next time TAMARIN is run, this will be risky if the attribute table is slightly different.

In some cases, it may not be the whole theme that has been revised but only one or more
attributes of a theme. The most likely example would be a revised prediction of land values or
opportunity costs, as a result of more data points in the sample, additions to or changes in the
independent variables, or improved regression modeling. The output may be a text or dBase
format file with columns for the ID number of the planning unit and for the new values. Add the
table to TAMARIN and proceed to Join the table to the Attributes table of the planning unit
theme by the unit ID number. Use the ‘Fields—>Calculate’ menu and calculate the attribute
fields with the value in the new table.

As noted in Section 3, some data layers are derived from the primary themes. Updating a
primary theme also requires updating the derived themes. In the case of revisions to the
Landcover theme, it will be necessary to reproduce the business-as-usual and restoration
themes based on the lookup table shown in section 3.3. The old themes must then be deleted
from TAMARIN’s views and from the folder, just as the primary theme was in the preceding
paragraphs. The new themes must be added to the Working View. In the Legend Editor, Load
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the restore.avl lookup table to color the cover classes. Do not change the theme name in the
Table of Contents of the view because TAMARIN expects to find it with that name.

You may wish to make different assumptions about future land use or restoration opportunities
than those made in the original version. Simply generate a new theme, give it a meaningful
name, and save it in the appropriate folder (in the case of business-as-usual and restoration
themes, this should be in the Options folder). Make sure the theme has the same projection
parameters as described in Section 3. When you run TAMARIN to create a new scenario, you
can specify your new themes as part of the opening dialog for ‘Define a scenario’. Likewise,
you may substitute a different planning unit theme based on other kinds of spatial units, such as
census tracts or squares of a different resolution. It will be necessary to compute summary
attribute data for these new units that correspond exactly to those in the original planning units
theme.

7.2 Modifications for Other Corridor Projects

Conservation planning for the Central Atlantic Forest Corridor was based primarily on meeting
broad conservation objectives (i.e., representation, redundancy, and resilience) in the most
economically efficient manner possible. The Corridor has been severely deforested, with only
about 9% on the region remaining in primary forest, mostly in small fragments. The focus in this
project was to decide on the best combination of protecting remaining fragments and restoring
forest to expand, connect, or complement those fragments. TAMARIN may not be particularly
useful in planning efforts where the conservation issues are significantly different than this. For
instance, TAMARIN would not be useful where the objective was to represent many different
habitat types to some specified level. In that case, a decision support system such as Sites 1.0
(Andelman et al. 1999) might be more appropriate (see
http://www.biogeoq.ucsb.edu/projects/tnc/toolbox.html).

If TAMARIN is suitable for use in a given corridor study, the themes for the new corridor must
correspond exactly to those for Bahia. The required GIS themes described in Section 3 are
used in the analysis procedures in TAMARIN. In addition, they are generally referenced by
their name in the view table of contents, so they must be given the same names in other
applications. Furthermore, the attributes of the themes, particularly for the planning units
theme, must exactly match those in the Bahia project, both in field name and its definition (e.g.
width, type, decimal places). Itis recommended that the themes be placed in the same folders
as their counterparts in the Bahia project. To do this, first delete the Bahia themes in the
TAMARIN view windows. Make a theme active by clicking on its legend in the Table of
Contents. Delete by using the ‘Edit->Delete’ menu. Save the project file and then delete the
Bahia themes from the folder by using the ‘File Management’ menu as described above or by
using ARC/INFO commands. If you do not remove a theme from the project and save the
project, the file manager will think the theme files are being used by an application and refuse to
let you delete them. Insert your own themes in the same folder, either with the same file
management dialog or with ARC/INFO commands.

The other issue in adapting TAMARIN to other areas is that much of the scripting was hard-
coded for the Bahia database. A prime example is where processing is based on specific cover
class values in the Landcover theme. A developer has two choices: either reclassify the
landcover theme to match the existing script or modify the script to match the new classification.
Ideally, the scripts would be modified so that they were more generic and adapted to whatever
the inputs in a particular region were rather than forcing the data to match a preconceived
classification. That is, an ideal new script would let the user describe the land use/cover
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classification and codes and the system could update all scripts that access that theme. This is
particularly important since classifications will rarely be identical between two regions.

Other examples of hard-wiring are in the summary analyses and reporting functions. For
instance, in the Central Atlantic Forest Corridor, evaluating the impacts of conservation
scenarios on prime farmland was an issue. Other corridors will have different issues and
corresponding GIS layers. ldeally, there would be some setup procedure to customize
TAMARIN for a particular region and that would only be run once at the beginning of the
planning process (not for each scenario). Perhaps this could take the form of having the
planner select the set of themes for which land cover summaries are to be made and
automatically revise the summarization script to treat each theme.

The following table lists the AVENUE scripts and dialogs (in italics) in TAMARIN that relate to
the steps in the flowchart in section 1.2.

1. Define scenario objectives
e Tam.ScenarioParams and Tam.ScenarioParams2
e Tam.openScenarioDialog and Tam.openScenarioDialog2
* Tam.acceptScenarioParams
e« Tam.PickBAU
« Tam.PickEasementValue
e Tam.PickEBI
e Tam.PickPUTheme
e Tam.PickRestore

2. Select planning units (and constrain by budget)
e Tam.chooseSiteSelector
e Tam.CompPoly and Tam.SortPoly
e Tam.PredefinedScenarios

3. Project future land use/cover
e Tam.FutureScenario

4. Evaluate socioeconomic and landscape impacts
* Tam.LandMetrics
» Tam.PatchSizeFreq
* Tam.Summarize Solution

Contact David Stoms at UCSB (stoms@bren.ucsb.edu) to discuss whether TAMARIN would be
appropriate for your application and how to modify it.
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ATTACHMENT A: FIELDS OF THE CELL990M THEME.

Field Name

Alias

Units

Meaning

Process

Gridid

Plan_Unit-ID

unique ID
number of unit

automatically generated from
row and column number

Hectares

ha

size in ha of
planning unit

Shape.ReturnArea / 10000

Land_Value

Reis per
planning unit

Total purchase
price of primary
and restorable
forestin
planning unit

Modeled from environmental
and locational variables by
Tim Thomas of the World
Bank

EaseVall

Easement_Valuel

Reis per
planning unit

Total
opportunity cost
of primary and
restorable forest
in planning unit

see section 3.1 for details

EaseVal2

Easement_Value2

Reis per
planning unit

Total
opportunity cost
of primary and
restorable forest
in planning unit

see section 3.1 for details

EaseVal3

Easement_Value3

Reis per
planning unit

Total
opportunity cost
of primary and
restorable forest
in planning unit

see section 3.1 for details

EaseVal4

Easement_Value4

Reis per
planning unit

Total
opportunity cost
of primary and
restorable forest
in planning unit

see section 3.1 for details

UsergVv

User_Defined_Easement

Reis per
planning unit

blank for user to
create their own
EV

Reestabcos

Re-establishmentCosts

Reis per
planning unit

Total cost of
restoration in
planning units;
$2000/ha if
required, else 0

Determine Restorable field
(yes if <= 1 km from primary
forest; if N, then invoke cost
as R$2000 * Restore_ha

InReserve

y/n

y if center of planning unit is
in reserve (then set EV and
LV to zero cost); else n
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Population

People per
planning unit
(or km2)

density

derived from census tract
data

Municipio

name of
municipio which
planning unit is
located in

municipio that the center of
the planning uni is located in

Cumcost

used for budget
constraint script

set to zero in this theme

Cost_add

used for budget
constraint script

set to zero in this theme

Pfor_ha

hectares

area in planning
unit with primary
forest

convert planning units to grid;
summarize landcover by unit
id; convert count to ha

Sfor_ha

hectares

area in planning
unit with
secondary
forest

Cab_ha

hectares

area in planning
unit with
cabruca

Euc_ha

hectares

area in planning
unit with
eucalyptus
plantation

Ag_ha

hectares

area in planning
unit with
agriculture

Bare_ha

hectares

area in planning
unit with bare
land

Urb_ha

hectares

area in planning
unit with urban

Otherhab_h

Otherhab_ha

hectares

area in planning
unit with
mangroves,
restinga,
caatinga,
wetlands, etc.

Nourbwat_h

Nourbwat_ha

area in planning
unit except
urban and
water; area for
which incentive
can be offered
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Restore_ha

hectares

area in planning
unit that can be
restored

sum of sfor_ha, cab_ha,
ag_ha, and bare_ha

Restorable

y/n

yes if w/in 1 km
of primary
forest, else n

see section 3.1 for details

Bioregion_

Bioregion_ID

bioregion that the center of
the planning uni is located in

Bioregion_

Bioregion_Name

EBI

EBI_Orig

index

original
Environmental
Benefis Index

see section 3.1 for details

EBI_LV

EBI_Pref LV

index

EBI_Pref
adjusted for
land values

EBI_Cab

index

modified
Environmental
Benefis Index
that gives more
weight to
cabruca than
original

EBI060401

EBI_Pref

index

preferred
Environmental
Benefis Index

UserEBI

User_Defined_EBI

index

blank EBI user
can create their
own EBI

Agclim

index

Agroclimatic
index from
Radambrasil
used to
estimate land
and easement
values

Declividad

slope class

Slope class
from
Radambrasil
used to
estimate land
and easement
values

Pedology

index

Soils index from
Radambrasil
used to
estimate land
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estimate land
and easement
values

Km2Paved

kilometers

Distance from
paved roads
used to
estimate land
and easement
values

mean of eucdistance from
paved roads theme

Km2Roads

kilometers

Distance from
all roads used
to estimate land
and easement
values

mean of eucdistance from all
roads theme

Km2Coast

kilometers

Distance from
coastline used
to estimate land
and easement
values

mean of eucdistance from
coastline derived from
corridor boundary

Propprimfo

proportion

Proportion of
planning unit
with primary
forest used to
estimate land
and easement
values

Propsecfor

proportion

Proportion of
planning unit
with secondary
forest used to
estimate land
and easement
values

Propcab

proportion

Proportion of
planning unit
with cabruca
used to
estimate land
and easement
values

EBIS

EBI_Core

index

Environmental
Benefis Index
using
neighborhood
habitat

see section 3.1 for details
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suitability

TestEBILV

EBI_Core_LV

index

EBI_Core
adjusted for
land values
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